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New size, faster chips, and more storage – that’s 
just a little of what you can expect from Apple’s 
new iPad Pro line-up, unveiled during WWDC.

In addition to upgrading its 12.9in iPad Pro (which 
originally launched in 2015), Apple released a new 
10.5in model that replaces the 9.7in version (which 
launched in 2016). We spent some hands-on time 
with the latest iPad Pro after the WWDC keynote. 

iPad Pro
Apple expands its range of tablets, reports Oscar Raymundo
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Price
10.5in iPad Pro: 
£649/£749: 64GB/64GB + Cellular,
£709/£839: 256GB/256GB + Cellular
£889/£1,019: 512GB/512GB + Cellular

12.9in iPad Pro: 
£769/£899: 64GB/64GB + Cellular
£859/£989: 256GB/256GB + Cellular
£1,039/£1,169: 512GB/512GB + Cellular

Colours
The 10.5in iPad Pro comes in Silver, Space Gray, Gold, 
and Rose Gold. The 12.9 version is available in Silver, 
Space Gray and Gold.

ProMotion technology
The iPad Pro models have a new trick up their sleeve. 
Apple has added a new feature called ProMotion, 
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which doubles the display refresh rate from 60- to 
120Hz. ProMotion also helps to automatically adjust 
this refresh rate depending on how you’re using the 
iPad Pro, as a way to conserve battery life.

True Tone
Apple has upgraded the original iPad Pro with True 
Tone. This means the Pro dynamically adjusts the 
screen’s white balance based on the lighting in the 
room to provide more-accurate colours on a paper-
white screen.

Performance
The iPad Pro models come equipped with the top-of-
the-line A10x fusion chip, plus a six-core CPU (three 
high performance cores and three high effi  ciency 
cores) and a 12-core GPU. This gives the new iPad Pro 
models 30 percent faster CPU performance and 40 
percent faster graphics performance than previous 
Pro models with the A9x chip.

Battery life
Despite improvements in speed and performance, 
Apple says that the 10.5- and the 12.9in model will 
deliver up to 10 hours of battery life, or nine hours if 
using an LTE model on a cellular connection. The 10.5in 
iPad Pro has a 30.4Wh rechargeable lithium-polymer 
battery, while the 12.9in model’s battery is a 41Wh .

Camera
The iPad Pro has camera specs modelled after the 
iPhone 7, so Live Photos and all their new editing 
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functions are available. Unfortunately, the iPad Pro does 
not have a dual-camera system, so you can’t use it to 
take photos in Portrait mode like on the iPhone 7.

Audio
The iPad Pro is equipped with four speakers, 
one near each corner to create an immersive 
‘soundstage’ experience. These speakers have also 
been programmed to produce a well-balanced 
sound, whether you are holding the iPad Pro 
vertically or horizontally. And a new casing design 
gives the Pro speakers 61 percent more back 
volume, a wider frequency range and up to 3x 
more acoustic output than previous iPads. 

Apple Pencil
Apple’s £99 stylus is pretty self-explanatory. You 
can use it to add handwritten notes to your digital 
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documents, but it’s also got some cool technology 
that will be particularly intriguing for sketch artists.

The Apple Pencil has several sensors on both its 
case and the tip that can detect the position, pressure, 
angle, and orientation of your strokes. Draw gently on 
the screen to create light strokes, or press down to draw 
thicker lines. Two sensors on the tip work with Multi-
Touch display to detect whenever you’re tilting the 
Pencil to create a shading eff ect. Apple Pencil can also 
be used simultaneously with your fi ngers, too, for those 
who have yet to graduate past the fi nger painting stage.

In iOS 11, Apple reduced the latency to an 
industry-best: 20 milliseconds. In addition, iPad 
Pro users can now use the Pencil to use Markup in 
screenshots and in documents scanned using the 
Notes app. In addition, the Notes app is able to search 
through your notes handwritten with the Pencil. 

Instead of an eraser at the tip, the Apple Pencil has 
a Lighting connector. Simply take off  the cap and plug 
the Pencil into your iPad Pro. Fully charged, it lasts up 
to 12 hours. And just having the stylus charging for 15 
seconds will get you 30 minutes of sketching time. 

Smart Keyboard
Think of the Smart Keyboard as an iPad Smart Cover but 
with a slim, foldable, lightweight, water-resistant, 4mm 
keyboard built in. In addition to using it to type, you 
can fold up the Smart Keyboard to prop up the iPad Pro 
or cover up the screen completely. Recently, Apple has 
added keyboard support for 30 languages, including 
Chinese and Japanese. It costs £159 for the 10.5in iPad 
Pro and £169 for the 12.9in model.
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Apple has created a three-pronged Smart Connector 
that allows for the Smart Keyboard to be connected to 
the iPad without plugs, wires, or Bluetooth pairing. It’s 
similar to how the Apple Watch’s diagnostic port works. 
The Smart Connector allows for the seamless transfer of 
data and power between devices, so you won’t have to 
charge the Smart Keyboard.
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Old iPad Pro cases
Most cases for the previous generation 12.9in iPad Pro 
should still fi t the upgraded 2017 model. The camera 
bump is a little more pronounced, but you should still 
be able to squeeze it in.

As for the cases designed for the 9.7in iPad Pro, 
they will not fi t on the new 10.5in model.

Accessories
Apple also has new £49 Smart Covers for the 10.5in 
model in seven colours. The £59 Smart Cover for the 
12.9in iPad Pro comes in only two colours: Charcoal 
Gray and White. In addition, Apple has brought back 
Leather Smart Covers to outfi t the iPad Pro. The 

Smart Cover
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10.5in Leather Smart Cover is £69 and comes in four 
colours. The 12.9in Leather Smart Cover is £79 and 
comes in three colours. Plus, Apple has released an 
all-new Leather Sleeve (£129 for 10.5in tablet and 
£149 for 12.9in iPad) that incorporates a special spot 
for Apple Pencil. You can also store the Apple Pencil 
in its own designated case that’s £29.

Multitasking
In iOS 9, Apple introduced three ways to view and 
interact with two apps simultaneously on an iPad Pro. 
These multitasking features have been refined and 
expended with each subsequent iOS release.

First, we have Slide Over, where you can choose 
a second app to open up as a pinned sidebar on the 
right or the left. Second, there’s Split View, where two 
apps each take up half of the screen. Apple introduced 
the ability to drag-and-drop in iOS 11, so you can 
seamlessly move text, photos, files, and URLs from 
one app to another. Finally, Picture-in-Picture lets you 
watch a video or chat on FaceTime while having another 
app running in the background. The video screen 
becomes a smaller window that you can drag and resize.

iOS 11 also brought other Mac-style capabilities 
to the iPad, including a new Dock and App Switcher. 
Like on macOS, this Dock gives you quick access to 
frequently used apps and documents from any screen. 
You can then drag these apps from the Dock to the 
right or left side of the screen to open in Slide Over 
or Split View. There’s also a new Files app that keeps all 
your files and documents in one place, whether they’re 
stored locally or in iCloud, Google Drive, or Dropbox.
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Siri in iOS 11 has learned to sound like an actual 
human – and that’s just the beginning when 
it comes to the new mobile operating system 

for iPhones and iPads.
Apple CEO Tim Cook and friends gave us a full 

overview of iOS 11 during Apple’s WWDC keynote. 
New features include sweeping new upgrades to Siri, 
a redesigned Control Center and App Store, and a 
brand-new Apple Pay feature that lets you send or 
receive money to your contacts via iMessage.

iOS 11
Oscar Raymundo looks at the biggest changes to Apple’s OS
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In addition, developers can now create apps that tap 
into your iOS device’s potential to create augmented 
reality experiences via the new ARKit. Plus, there 
are new productivity features for the iPad, including 
drag-and-drop capability and a new Mac-style Dock.

Compatible devices
•  iPhone 7/Plus
•  iPhone 6s/Plus
•  iPhone 6/Plus
•  iPhone SE
•  iPhone 5s 
•  iPad Pro (12.9-, 10.5-, and 9.7in)
•  iPad Air
•  iPad Air 2
•  iPad (5th generation)
•  iPad mini 2/3/4
•  iPod Touch (6th generation)

Release date
Following a series of developer and public betas this 
summer, Apple will make iOS 11 available to everyone 
as a free upgrade later this autumn – likely around the 
same time as the launch of the next iPhone, typically 
in early or mid-September. 

Public beta
Apple is expected to start rolling out the first public 
beta in June and anyone can give it a whirl (at their 
own risk). First, log in to the Beta Software Program 
page (tinyurl.com/pkmbuxz) using your Apple ID and 
click on the link to enrol your iOS device. In order to 
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download and install a confi guration profi le, you’ll be 
instructed to go to beta.apple.com/profi le on the iOS 
device that you want to put the beta on – that will 
make the beta available as an over-the-air software 
update in the Settings app.

Just remember that this is a beta version of the new 
software, so make sure you backup your iOS device 
before venturing into this unknown territory. Better yet, 
we recommend installing the public beta profi le on a 
secondary iOS device (if you have one) so that you can 
test it without fear that it will screw something up.

iOS 11 FAQ
What new features does Siri off er? 
The fi rst new thing you’ll notice about Siri in iOS 11 
is her more-natural sounding voice. However, she 
also looks a little diff erent: Apple has given its voice 
assistant a new visual interface that surfaces multiple 
results for your requests, as well as follow-up questions. 
In addition, Siri can now translate phrases for you, 
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from English to Chinese, French, German, Italian, 
and Spanish. This feature is in beta, and Apple will 
add more languages in the months to come.

Siri has also become more predictive across 
different iOS apps. For example, if you search for 
‘Iceland’ in Safari, Siri will surface Iceland-related 
articles in the News app and bring up QuickType 
suggestions in Icelandic. Or, if you get a text message 
asking for money, Siri will suggest iMessage’s Apple 
Pay integration with the exact amount that’s been 
requested. Apple has also expanded SiriKit support 
to include more robust integrations with third-party 
services. You can now use Siri to add to your Evernote 
or pull up a QR code in WeChat, among other things.

Can I do more with Live Photos? 
Apple has given us more editing tools for Live Photos, 
those moving images that you can take using an 
iPhone 6s and later. You can turn your Live Photos into 
video loops that replay over... and over... and over. The 
Photos app will even suggest Live Photos that would 
make for great loops. You can also add a ‘Bounce’ 
effect so that the Live Photo plays and then rewinds, 
kind of like Instagram Boomerangs. There’s also a 
new Long Exposure effect which makes the iPhone 
even more like a DSLR.

Do Live Photos take up a lot of space?
That’s true, but thankfully Apple has addressed this 
issue by switching to a more space efficient encoding 
system. For videos, iOS 11 uses HEVC (aka H.265), 
which is twice as efficient as the previous H.264 
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format. For still photos, iOS 11 uses HEIF, which Apple 
claims will take up only half the space.

Where will I be able to use maps indoors?
Apple continues to improve the native Maps app in 
iOS 11. For the fi rst time, you’ll be able to use Maps 
to navigate your way around indoor spaces. Maps in 
iOS 11 introduces indoor mapping so you can get 
detailed fl oor plans of certain shopping centres and 
major airports, such as London Heathrow, down to 
individual vendors on each fl oor.

How does ‘Do not Disturb While Driving’ work? 
Another feature introduced at WWDC is iOS 11’s ‘Do 
Not Disturb While Driving’ mode. Your iPhone will use 
Bluetooth (if connected to CarPlay or any other in-
vehicle Bluetooth system) or motion sensors to fi gure 
out if you’re driving, and will automatically prevent all 
notifi cations from surfacing and causing a distraction. 
You can override this mode, however, or setup an 
automatic response to let people who text you know 
you’re on the road and that you’ll get back to them 
as soon as you arrive at your destination.

What about augmented reality? 
Tim Cook has spent all year talking about how excited 
he is for augmented reality, so it’s no surprise that 
Apple used this year’s WWDC keynote to show off  
what they’ve been working on in this emerging 
area. Alongside iOS 11, Apple unveiled ARKit, a new 
developer platform for creating iOS apps that tap into 
augmented reality. Apps built with ARKit will be able 
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to use computer vision to identify surfaces and add 
3D objects. These objects create dynamic shadows 
that are rendered in real-time.

Did the iPad get more macOS-type features?
There’s a new app Dock that looks a lot like the one in 
macOS, making it a lot easier to switch between apps. 
You can also press on any of these apps and drag them 
over to the right side of the screen to open them as 
a Slide Over. As always, you can lock Slide Over into 
Split View to use both apps simultaneously.

The Dock can be accessed from any screen and you 
can customize it with your favourite apps. Also, it has 
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a dynamic section on the right side that changes to 
suggest recently-used apps across your Apple devices.

What about drag-and-drop?
With iOS 11, you can drag-and-drop between the two 
apps in Split View, which makes it easier to transfer 
fi les, images, text, and URLs. You can drag-attach 
images from the Photos to Mail, or drag-copy-and-paste 
directions from Safari into Maps.

And how does the new Files app work?
Apple also launched Files, a new iOS app intended to 
make the iPad experience more like a traditional Mac. 
Pretty self-explanatory, Files displays your documents 
stored in iCloud, Dropbox, Google Drive, and other 
fi le-storage apps.

Are there new ways to use Apple Pencil?
Apple has expanded Apple Pencil support for the iPad 
Pro. Tap a PDF or screenshot with the tip of the stylus 
and you’ll be able to scribble on it instantly thanks to 
a new feature called Instant Markup. Similarly, you can 
Pencil tap on the Lock screen to start writing. All your 
handwritten creations will be saved to your Notes app, 
and these handwritten notes are searchable, too.

Notes also has a new built-in Document Scanner, 
allowing you to scan a document, sign it or mark on 
it with Apple Pencil, then save or share. Plus, Notes 
and Mail now support Inline Drawing so you can 
add colour to your emails and notes. The text will 
automatically move out of the way when you start 
drawing, so everything remains legible.
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A few more things...
Control Center has been redesigned so that it’s only 
one panel. You can customize it with your go-to’s 
such as Low-Power Mode and use 3D Touch to adjust 
more specific controls.

App Store mirrors the look-and-feel of Apple Music, 
with a new Today tab for featured games and apps.

Messages App Drawer makes it easier to access your 
favourite iMessage apps by swiping across the bottom 
of the screen, instead of having to tap back to the 
drawer every time you want to switch apps.

Apple Music gets more social. New profile photos 
indicate when one of your friends has listened to a 
certain albums or playlist.
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Apple used its WWDC keynote to give us a sneak 
peek of an all-new product: the HomePod. 
Originally rumoured to be called Siri Speaker, 

the HomePod is a smart speaker with Wi-Fi capabilities 
intended to compete against Amazon Echo devices and 
Google Home – although it will be signifi cantly more 
expensive. During the keynote, Apple’s senior VP of 
marketing Phil Schiller boasted about the HomePod’s 

HomePad
Does the HomePod have enough features to compete against 
Amazon Echo and Google Home? Oscar Raymundo reports
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audio quality, its built-in room sensors, and the 
integration with Apple Music. 

With its always-on voice assistant and ability 
to control connected devices, the HomePod is 
very similar to Echo devices and Google Home, 
but with a few notable differences. Here are the 
must-know HomePod features, specifications, and 
sales information showcased during WWDC.

Release date
The HomePod will be available for sale starting in 
December, initially in the UK, the US and Australia. 
So it’s will only support English-language voice 
commands during the initial rollout. It will then be 
available in other countries starting in 2018.

Price
The HomePod costs $349 in the US and we estimate 
it will be £349 in the UK. It will be available in two 
colours: White and Space Gray. By comparison, Amazon 
Echo is £149 from tinyurl.com/y96duarw, while 
Google Home retails for £129 from fave.co/2skmLpc.

Intelligence
The HomePod comes with an A8 fusion chip, the 
same one that powers the iPhone 6 and 6 Plus. 
That definitely puts it up at the top when it comes 
to ‘smart’ speakers. Like the AirPods (which sport 
an A1 chip), setting up the HomePod is just as easy 
and intuitive. All you have to do is hold your iPhone 
next to the HomePod and it’ll be ready to start 
playing music in seconds.
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How to activate it
The HomePod has six microphones so that it can be 
activated verbally using the “Hey Siri” voice command. 
We’re not sure what happens if you have “Hey Siri” 
activated on your nearby iPhone as well. Hopefully, 
Apple implements a way for you to customize which 
device responds and fulfi ls the voice commands, or 
for the iPhone and the HomePod to communicate 
with each other and fi gure it out. 
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Siri
You can ask Siri to send a text message to your friend, 
start playing the latest episode of your favourite 
podcast, and get the latest updates in news, sports, 
traffic, and weather. You can also use voice commands 
to set alarms, timers, and reminders. In addition, 
Siri on the HomePod can help you answer some of 
your most burning questions such as, “What’s the 
best Indian restaurant nearby?” or “Did Manchester 
United win last night?”

Controls
The HomePod does not have a touchscreen like the 
more-recent Amazon Show, but it can still responds 
to touch controls. You can tap the top of HomePod 
to play, pause, or adjust the volume. This panel 
also animates with an LED waveform to indicate 
whenever Siri is listening.

HomeKit devices
You can ask Siri to turn on the lights, close the shades, 
or activate a scene that you’ve preset in the Home 
app. HomePod can even control these devices when 
you’re not home via the Home app, giving you the 
power to remotely control your devices from anywhere. 
So far, HomeKit compatible with connected devices 
from Ecobee, Honeywell, August, Kwikset, Philips Hue, 
Lutron, and more.

Audio 
Apple wanted to create a speaker that delivered state-
of-the-art sound that ‘rocks the house’. The HomePod 
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includes an Apple-designed four-inch woofer for a 
deeper bass and seven beam-forming tweeters for 
high frequency acoustics. All of this was designed 
to preserve the richness and intent of the original 
recordings. Of course, we won’t be able to vouch 
for this until we get to listen to it later this year.

Multi-room audio
Thanks to the new AirPlay 2, Wi-Fi speakers are now 
part of the HomeKit family so you can get multi-room 
audio controls from a single iPhone. This gives you 
the option to use the Home app to control multiple 
HomePods in diff erent rooms and sync audio playback. 
Furthermore, AirPlay 2 is also compatible with Wi-Fi 
speakers from other manufacturers, including Bose, 
Bang & Olufsen, Bowers & Wilkins, and Apple’s Beats.

Spotify
Unfortunately, the only music streaming service that 
the HomePod supports is ... Apple Music. In fact, Apple 
claims the smart speaker was designed to be deeply 
tied to Apple Music, which costs £9.99 per month. 
And we don’t foresee Apple bringing another other 
services to the fold anytime soon (or ever).

Apple Music
If you’re an Apple Music member, the HomePod can 
access Apple Music’s full catalogue, as well as tap into 
machine learning to learn about your music preferences 
and suggest songs and artists you might like. Apple 
refers to the HomePod as the perfect musicologist. 
In addition, you can create a shared Up Next queue 
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with other nearby iOS devices so that everyone in the 
house can participate in picking music.

New technology
Not every room is the same, so the HomePod has 
learned about spatial awareness. Its built-in sensors 
can determine the size and layout of its surroundings 
to automatically deliver the volume and acoustic 
output that best fi lls the room. Think of it as virtual 
surround sound. When two paired HomePods are 
in the room, they’ll be able to sense each other to 
deliver actual surround sound.

Privacy 
Privacy is also being touted as a vital component. 
According to Apple, the smart speaker will only 
start collecting information after the ‘Hey Siri’ voice 
command is activated. This means that you shouldn’t 
be afraid that the HomePod is secretly recording your 
conversations in order to sell you stuff . All information 
is recorded locally on the device and sent to Apple 
servers encrypted using an anonymous Siri ID.

IPAD & IPHONE USER 121.indd   25 16/06/2017   12:14



26 ISSUE 121 • iPAD & iPHONE USER

WWDC 2017

The Apple Watch might still feel like a new product, 
but its already on the fourth version of watchOS. 
And each one has brought some pretty major 

changes. Version 2 brought nightstand mode and third-
party complications, and version 3 introduced the dock, 
a new Breathe app, and better overall navigation.

However, watchOS 4, unveiled at the Worldwide 
Developers Conference keynote in San Jose, is 
more of a maintenance release than a full new version. 

watchOS 4
Michael Simon looks at the operating systems new features
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Still, it brings some cool new ways to interact with 
our favourite apps and add a little fun to the screen 
we see the most. Here’s everything we know so far 
about watchOS 4, including a few new features that 
we can’t wait to try.

Compatible devices
Apple Watch is a new enough product so no models 
are excluded from the new version. Whether you own 
one of the originals, or a Series 1 or a Series 2 watch, 
you’ll be able to install watchOS 4 when it arrives.

Release date
Apple will release watchOS in the autumn, most likely 
on the same day as it releases iOS 11 for download.

Public beta
Unlike iOS and OS X, Apple hasn’t previously offered 
a public beta program for watchOS. It’s possible that 
changes this year, but we have no reason to think it 
will. So to try it out before the masses you’ll need 
to sign up for a developer program membership for 
£99 per year. However, if you do decide to go that 
route, keep in mind that Apple doesn’t allow you to 
downgrade to an earlier watchOS version without 
taking it into an Apple Store for repair.

watchOS 4 FAQ
Has the navigation changed? 
A little. The Dock that holds your apps your apps now 
scrolls vertically rather than horizontally, making better 
use of the Digital Crown. You can also choose to ditch 
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the honeycomb home screen with a new list view that 
will simply display a vertical list of your installed apps.

What’s the Siri face?
The biggest change to watchOS 4 is the addition of a 
few new faces, most notably a Siri face. Built for people 
who crave a steady stream of information on their 
wrists, the Siri face will automatically display the most 
relevant info based on the time, your location, and 
your routine. For example, if you usually drive to work 
at 8am, it will display the traffi  c, or if you use HomeKit 
to shut your lights at night, that button will appear at 
bedtime. Additionally, you can rotate the crown to cycle 
through the various cards. Whenever you raise your 
wrist, the face will dynamically update with the latest 
bit of relevant info, and if you need to know something 
that isn’t displayed, you can also tap the new Siri 
complication to ask a question.

What’s the Kaleidoscope face?
Where the Siri face off ers always-changing information 
designed to keep you organized and motivated, the 
kaleidoscope face off ers always-changing pattern 
designed to keep you happy. Just like those long tubes 
that you held up to the light and rotated to change 
shape, the new kaleidoscope face uses your photos 
to create a circular pattern that constantly moves and 
changes throughout the day. 

Are there really Toy Story faces?
Yup. Woody, Jesse, and Buzz join Mickey and Minnie 
as Apple Watch faces, but there’s a twist. Instead of 
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using their hands to show the hour and minute, the 
faces feature a simple digital clock and date and let 
the characters frolic around it. And each time you 
raise your wrist to check the time, you’ll get a random 
little animated vignette.

Enough about faces. Tell me about fitness
Apple has tweaked the Activity app to make us a little 
more likely to use it. Achievement progress alerts will 
let you know if you’re close to accomplishing a goal or 
tell you what you can do to match yesterday’s numbers. 
And there will also be personalized monthly challenges 
that inspire you to push a little harder. And in case 
you need a little more motivation, there’s also a cooler 
animation when you close all three rings and even 
bigger celebrations for hitting monthly milestones.
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Has the Workout app changed too?
Apple has made the Workout app easier to use with 
a new interface that puts a quick start button front 
and center. Also upgraded is the app’s swimming 
capabilities, adding distance and pace trackers as well 
as auto sets, so if you’re swimming laps it will recognize 
when you rest at the edge of the pool. There’s also 
a new option for High Intensity Interval Training and 
the ability to swipe to add a new workout to the same 
session. And you’ll also be able to set a playlist to start 
automatically when your workout begins.

What if I work out at a gym?
If you use gym equipment like a StairMaster or treadmill 
to burn your calories, you can now tap into all of data 
inside it using a new two-way data exchange feature 
will keep your metrics in sync. Apple has partnered with 
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top brands, including LifeFitness, Cybex and Matrix, 
to equip their machines with NFC readers that will 
seamlessly sync to your watch.

Any changes to music?
The Music app now automatically syncs music based 
on your tastes, and navigation is now album-art 
based, letting you use the crown to scroll through 
your songs like on a tiny digital jukebox. Plus, you 
can now send more than playlist to your watch.

Any new apps?
For now, all we know is that there will be a new 
Apple News app for the watch, which will display 
headlines on the Siri face and let you save articles 
for later reading on your phone.

What’s this about a flashlight?
Apple is adding a new flashlight icon to the Control 
Center that will let you see in the dark or use it as 
a blinking safety light when cycling. Apple hasn’t 
shown us how it will work, but presumably it will put 
a bright white screen on the watch for illumination.

Any improvements to Apple Pay?
With watchOS 4, you can send payments to your 
friends right on your watch. You’ll be able to send 
money to anyone in your contacts using Apple Pay, 
and they’ll receive the money in their new Apple 
Pay Cash account. Then, they’ll be able to transfer it 
to their bank account or keep the funds around for 
future Apple Pay purchases.
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Once a year, at WWDC, Apple unveils its latest 
major update to the iOS software on iPads and 
iPhones, which will be launched to the public 

in autumn. But before then, they will be available for a 
limited time to the select few: the beta testers.

Developer beta
First, you’ll need to join the beta programme. You 
can register as an Apple developer and join the iOS 

Get iOS 11 beta
Lewis Painter reveals how to get your hands on the iOS early
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Developer Program at tinyurl.com/732huk3. It costs £99 
per year and you can enrol using your Apple ID.

Before you start, back up the device you’re going 
to install the beta on. That way you can restore it if 
something goes seriously wrong. Alternatively, if you 
are lucky enough to have a second handset, use that.

Sign into the iOS Dev Center (tinyurl.com/L4wvz8t ) 
using your Apple ID. Next, register your Apple device’s 
UDID – to find this plug the device into iTunes, click 
on the device’s icon in the top right-hand corner, view 
the Summary tab and click on the Serial Number entry 
to get it to change to the UDID. You’ll now be able to 
download the appropriate version of the iOS beta for 
your hardware – select the exact iPhone, iPod touch or 
iPad model you’re using from the list. Unzip the file that 
downloads to your Mac (this should produce a .IPSW 
file). Connect your device to iTunes (if it isn’t already). 
Hold Alt and click the Restore iPhone button on the 
device’s Summary tab (next to Check for Update). Select 
the .IPSW file from the previous step. The iOS beta will 
be installed on your iPad or iPhone after a few minutes.

Public beta
There is a beta programme for members of the public 
who are willing to install a prerelease version of the 
next iOS update on their devices, bugs and all, and 
provide feedback on any issues that need to be ironed 
out. Apple has experienced problems with final public 
launches in the past, and the public beta programme is 
a bid to prevent that from happening again.

You can join the programme by clicking Sign Up on 
the Apple Beta page (tinyurl.com/pffuwnz) and use 
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your Apple ID. We can’t stress how important it is to 
back up your device before you download and install 
a beta version of iOS, or as we recommend above, use 
a secondary device that isn’t your main iPhone or iPad. 
Not only will that mean you won’t lose everything if 
something goes wrong while the beta is installing, it 
also means you’ll be able to go back to the last version 
should you fi nd that you don’t like the new software 
after all, or that it’s too buggy. 

Next, click Sign Up on the Apple Beta page and use 
your Apple ID. You’ll then be able to log in to the Beta 
Software Program, and click Enrol. From there, you’ll be 
instructed to go to beta.apple.com/profi le on your iOS 
device in order to download and install a confi guration 
profi le. That will make the beta available in the Settings 
app, under General > Software Update.
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When Apple released Swift Playgrounds in 
2016, it opened the world of coding to kids 
(and adults) who thought just the idea of 

creating an app was intimidating. Swift Playgrounds 
makes codes approachable and fun to learn, combining 
tutorials, a touch interface, and ‘challenges’ on an iPad 
that anyone can use for free.

While Swift Playgrounds can be a very satisfying 
experience that results in your very own app, 

Swift Playgrounds 1.5
Students can learn how to write code to control products from 
Lego, Parrot, Sphero, and more, finds Roman Loyola
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technology moves forward – we’re now in a world where 
drones and robots are prevalent. With that in mind, 
Apple announced Swift Playgrounds version 1.5 at 
WWDC, which includes tools that teach students how to 
control drones and robots over Bluetooth using an iPad.

The new program gives teachers access to Swift 
Playgrounds curriculum that works with a number 
of robots and drones, including products from 
Lego, Parrot, Sphero, Ubtech Robotics, and Wonder 
Workshop. Since Swift is an open-source language, 
Apple says that makes it easy for other companies to 
jump on the bandwagon.

The addition of drone and robot support expands 
Swift Playgrounds’ content library, and the direct results 
experienced by students can be satisfying and help 
maintain interest in coding. “Kids know the difference 
between writing something that’s real and writing 
something that’s not real,” said Cheryl Thomas, Apple 
VP of Engineering, Swift Playgrounds.

Teachers can access the new Swift Playgrounds 1.5 
as a free download in the App Store. The app requires 
iOS 10 or later, and can run on all iPad Air and iPad 
Pro models, as well as the iPad mini 2. Support is 
provided through Apple’s Education program, which 
includes Professional Learning Specialists to help 
with the lessons.

Since its introduction in 2014, Swift has been 
embraced by software developers. Apple said that 
over 250,000 apps have been created using Swift. The 
company is also excited by Swift Playgrounds; at the 
version 1.5 event, Apple representatives said the over a 
million unique users have used the learning software.
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Children love iPhones and iPads. They love to look 
at them, they love to tap and swipe the screen, 
they love playing iPhone games, and most of 

all, they love watching videos on them. Giving your 
little ones a hand-me-down iOS device is an easy way 
to satisfy their desire for a screen of their own – my 
daughter is the proud owner of an iPhone 3GS and a 

What to do before giving 
your child an old iPhone

Don’t hand over an ageing iOS device to your eager youngster 
before doing a little childproofing first. Ben Patterson shows how
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third-generation iPad. That said, you shouldn’t hand 
over your old iPhone or iPad without doing some kid-
proofing first. Read on for five ways to prep an aging 
iPhone or iPad for your youngster, from wiping your 
data and setting up a child’s iCloud account to blocking 
web access and keeping her from racking up in-app 
charges on your credit card.

1. Wipe your old data
Before you hand over your old iPhone to your kids, 
you’ll want to make sure any and all of your personal 
data has been wiped clean. The best way to do so is 
to perform a ‘factory’ reset, which wipes the iPhone’s 
storage and returns it to its factory settings.

Naturally, you should first make sure you’ve backed 
up any old iPhone or iPad data you want to preserve. 
You may already have taken care of this step if you’ve 

Make sure to back up 
and then wipe your data 
before handing over your 
old iPhone to your child
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previously upgraded to a new iPhone or iPad and 
restored your data from iCloud. If not, tap Settings, tap 
your iCloud profile, then tap iCloud > Backup > Back 
Up Now. You can also back up your old iPhone or iPad 
by connecting it to your Mac or PC and syncing it with 
iTunes. Once you’re satisfied that your data is safe and 
sound, go ahead and wipe the device. Tap Settings > 
General > Reset > Erase All Content and Settings. Once 
the reset is complete, your old iPhone or iPad will 
return to its factory settings, just like the day it came 
out of the box.

2. Create a child’s iCloud account
While it may seem a little soon to, say, create an Apple 
ID for a toddler, take it from me: it won’t be long before 
your onesie-clad child is walking, talking and pleading 
for an iPhone upgrade – and when that happens, it’ll be 

Just because your child is 
under 13 doesn’t mean she 
can’t have her own iCloud 
account and Apple ID
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easier to migrate her data and apps if she already has 
her own iCloud account.

Even if your child is younger than 13 years old, she 
can still have her own iCloud account and Apple ID. 
All you need to do is create the account under iOS’s 
‘Family Sharing’ umbrella. With her iCloud account, your 
child will be able to sign in to an old iPhone or iPad, 
download apps, and even purchase items from the App 
Store – only with your approval, of course.

Also, keep in mind that just because she has an 
iCloud account, your daughter or son won’t be able 
to start web surfing, tweeting, or posting selfies on 
Instagram without your say-so. 

You can create a child’s iCloud account directly on 
your own iPhone or iPad. Just tap Settings, tap your 
iCloud username, then tap Family Sharing > Add Family 
Member > Create an Apple ID for a child. You’ll need 
to enter your kid’s birthday, agree to some disclosures 
and legalese, choose a payment method for App Store 
purchases (which, again, you can control and/or block), 
then choose an Apple ID username and password.

By default, your kid’s new iCloud account won’t let 
her make App Store purchases without your consent. 
To double-check the ‘Ask to Buy’ setting, tap Settings, 
tap your iCloud account name, then tap Family Sharing 
and your kid’s name.

3. Control what your child can, and can’t, access
Once you’ve got your old iPhone or iPad set up with 
your child’s new iCloud account, it’s time to make some 
decisions on which iOS features will be fair game for 
your kid, and which will be off-limits. Tap Settings > 
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General > Restrictions > Enable Restrictions, then create 
a Restrictions passcode. Next, scroll down and disable 
all the iOS features that you’d rather your kid not mess 
with. You’ll probably want to disable Safari and the 
iTunes store right away. You may also want to block 
your child from installing apps, and if you don’t want 
your little one snapping a million photos of their crib, 
you might want to restrict the Camera app, too.

In the Allowed Content section, make sure to disable 
in-app purchases, as well as block music with explicit 
music and any grown-up movies, TV shows and books. 
In the Privacy section, you can control which apps can 
access location services, contacts, the microphone, 
and more on your kid’s iPhone. At the bottom of the 
Restrictions screen, you can also disable access to 

Don’t want your child surfing 
the web or snapping photos 
on her hand-me-down iPhone? 
You can block those activities in 
iOS’s Restrictions settings
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multiplayer games, friend adding, and screen recording 
for any Game Center-ready games.

4. Hide Settings, Mail, and other Apple apps
Even after you’ve thoroughly managed all of iOS’s 
Restrictions settings, you may still see some home-
screen icons on your kid’s iPhone or iPad that you’d 
rather she not mess with. For example, the Settings icon 
should probably stay out of her hands, as well as the 
Mail app, Game Center, and the App Store.

Here’s what I did before I gave my daughter my 
old iPhone: I hid all those various Apple apps in a 
‘Hidden’ folder in the very last iOS home screen. To 
create a home screen folder, drag one app icon on top 
of another, name the folder, then start dragging other 
app icons into the newly created folder. Naturally, older 
children who are a bit more iOS savvy may sniff out this. 

You can hide the Mail, 
App Store, and other 
Apple apps in a folder, 
preferably on its own 
home screen in the back
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My five-year-old, for example, knows exactly where I’ve 
tucked away the Settings icon, but she doesn’t care.

5. Turn on Airplane mode
One way to make sure your little one doesn’t wander 
into a grown-up corner of the Internet on her iPhone is 
to cut off Internet access altogether, and the easiest way 
to do that is to turn on Airplane mode. Just tap Settings, 
then flip on the Airplane Mode switch.

If your old iPhone or iPad is running on iOS 6 or later, 
you may also want to disable home screen and in-
app access to Control Center, the flip-up control panel 
that includes an Airplane Mode button, To do so, tap 
Settings > Control Center, then switch off the Access on 
Lock Screen and Access Within Apps settings. That won’t 
completely disable Control Center, but at least it’ll make 
it a tad more challenging to find.

Turning on Airplane 
mode is an easy way 
to keep tiny iPhone 
users off the Internet
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Listen to Beats 1 playlists off the air
If 24-hour live radio station Beats 1 is giving you a 
serious case of FOMO because you keep missing all 
the great parts, then catch up by streaming shows on-
demand. Tap Radio > View All Beats 1 Shows and scroll 
past what’s currently on air and upcoming shows to find 
all shows. Tap a specific show, then stream the episode 
you missed. Just want to hear the songs that Elton John 
played on his show and not listen to the entire episode? 
Each show displays the on-demand episodes and 
playlists from each episode, which you can save to your 
music library or download to listen to offline.

Apple Music tips 
Get more from Apple’s music streaming service with Caitlin 
McGarry and Susie Ochs tips and tricks
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Stream a song to wake you up
Many of us already use our iPhones as alarm clocks, but 
with Apple Music, alerts just got a whole lot more fun. 
First, make sure to add the songs you want to use for 
your alarms to My Music. Then open Clock > Alarm and 
either add a new alarm or edit an old one. Above the 
standard ringtone selection you would normally pick 
from, there’s an option to pick a song from your Apple 
Music catalogue. The possibilities are endless.
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Make friends with Siri
Siri in iOS 10 is more powerful, but Apple’s personal 
assistant has been making Apple Music easier to use 
since its launch. Here are a few of our favourite Siri 
capabilities when it comes to managing music: when 
you’re listening to a song, say, “Play more like this one,” 
to create an immediately personalized playlist tailored 
right to your mood. You don’t even have to know the 
name of the song you want to listen to. Ask Siri to play 
hits from a certain year or that one song from that one 
TV show, and it knows what to do. Siri can shuffl  e play 
any playlist or album you want her to. Siri can add 
songs to your collection.

You don’t even have to have the Music app open for 
Siri to work its magic, which is our favourite part. It can 
be your personal DJ without any eff ort on your part, 
which is a feature no other streaming service can match.
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Improve your recommendations
You already told Apple Music the genres and artists 
you love (and hate) when you signed up, and the app 
has used that information to create some pretty on-
point playlist, artist, and album recommendations in 
the For You section. But you can keep fi ne-tuning your 
preferences with every song you listen to, so Apple 
Music will one day know exactly what you want to hear.

Use the heart button, located in a menu behind the 
ellipses on every Now Playing page, liberally on songs 
and playlists so Apple Music knows what you like. Hate 
something recommended to you in For You? Give it an 
extra long press and more options will show up. At the 
bottom, tap on Dislike to show your distaste. Eventually, 
your recommendations will be perfectly on point.
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Or just pick new favourites
If you didn’t do a good enough job selecting your 
preferred genres and artists when you fi rst launched the 
Music app, you can give yourself a second chance. Go 
to the For You tab, then tap your profi le photo in the top 
right to open your account page. Then just tap Choose 
Artists for You, and you’ll get to do the whole thing 
again. Remember, tap once to like a genre or artist, tap 
again to really like it, and tap and hold to make the ones 
you don’t care for disappear. Slide the display back and 
forth with your fi nger, and on the artist screen you can 
tap More Artists to see additional choices.
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Personalize playlists with photos
Your playlists have diff erent names (we assume), but 
they all sort of look the same, marked by an icon with 
a grid of album covers indistinguishable from the next. 
But you can customize each soundtrack with a photo 
instead, either as you’re creating the playlist or after. 
Go to Library > Playlists > New Playlist and tap on the 
Camera button in the top left corner. 

From there you can add an image from your Camera 
Roll or take a new photo. If you want to change it 
later, go to the playlist, tap Edit on the top right, and 
then tap the little camera icon that appears over the 
playlist’s cover image. Apple Music used to customize 
each playlist with a background colour to complement 
your cover image, but those days are gone. Every 
playlist has a white background.
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Music in loud spaces
If you’re trying to block out the world and jam to your 
tunes in peace, the Music app has a setting for easier 
listening in loud spaces like airplanes. Go to Settings > 
Music > Playback > EQ and tap the Late Night option. 
According to Apple, this setting will “compress the 
dynamic range of audio output”, which tones down 
loud sounds so they won’t be so loud and pumps up the 
sound on quiet parts, so you won’t have to constantly 
change the volume controls to fi nd an even keel.
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Tweak a ‘For You’ playlist’s order
It’s easy to shuffl  e a For You playlist – each one has a 
Shuffl  e button right at the top. Or you can tap any song 
to begin the playlist at that point and play the rest in 
order. But if you want to tweak the order to your exact 
liking, or even ditch a song before it plays, just start the 
playlist going and then tap the mini player, and the Up 
Next button. Then you can drag the songs into a new 
order by pressing the hamburger button (three lines in a 
stack) and dragging them up or down, or swipe right-to-
left on a song you don’t want to hear and tap Remove.

Note that this doesn’t alter the playlist permanently. 
If you’ve saved it to your library, it’ll still appear in 
its original order, with all the songs present. If the 
curator changes it later, it’ll update in your collection 
automatically, but we wish Apple let us duplicate a 
curated playlist so we can add, remove and reorder 
songs and save it as a personalized new soundtrack.
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Share a song
Listening to a song you love and have to share it with 
your friends immediately? Open the iMessage app 
drawer and select Music, where you’ll see your most 
recently played songs from Apple Music. If they’re also 
running iOS 10 on their device, the message will display 
as a rich link to play the song without leaving Messages.

You can also share a song in a text message in Apple 
Music itself, but that will show up as an iTunes link 
and launch the Music app when you try to play it, as 
opposed to playing directly inside the iMessage thread.
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See the album, or more from the artist
Apple Music 1.0 buried everything behind ellipses. 
Want to navigate to an artist’s page from an album 
view? Ellipses. Want to view an album while playing a 
song? Ellipses. Those days are gone, thank goodness.

Now when you long press on a song, you can tap 
through to the artist’s page or the album, in addition 
to all the other options that were buried in the ellipses 
menu: add to library, add to a playlist, play next, play 
later, create station, share song, love, or dislike. The 
fonts are bigger, so you can actually see what you’re 
tapping on instead of squinting and hoping for the best.
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Listen over cellular, but watch your data
If you get an error that you can’t listen to Apple Music 
without Wi-Fi, go to Settings > Music, and turn on the 
option to Use Cellular Data.

Weirdly, there’s also a switch to allow the Music app 
to use cellular data in Settings > Cellular that should do 
the same thing – and that menu even shows you how 
much data the Music app has consumed.
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Sing along
No more Googling a song to fi gure out if Taylor Swift is 
singing “Starbucks lovers” or “long list of ex-lovers” (it 
should be the former but it’s defi nitely the latter). iOS 
10 brought lyrics to Apple Music, so you can sing along 
and sound like you know every line to every song.

The mini-player used to be just a screen with some 
album artwork and an ellipses icon to access more 
options – very bare-bones. Now when you swipe up 
from the Now Playing screen, you’ll see a song’s lyrics 
(which you can easily hide), song credits, and tracks 
that are playing next. We’re still not exactly sure how to 
song along with Kiiara’s Gold, but we’re closer now than 
we were before. Thanks, Apple Music.
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Siri or Google Assistant? Well, that depends on 
how you plan to use your iPhone’s voice assistant. 
While Google has made great strides in artifi cial 

intelligence, Siri has the perks of being seamlessly 
integrated into iOS, like waking it up by long-pressing 
the Home button or hands free by calling out “Hey Siri”.

We tested Google Assistant and Siri by asking them 
to tap into third-party services and to conduct some 
complex web searches. 

Siri vs Google Assistant
Google Assistant is available on iOS, giving Siri some competition 
on its how turf. Oscar Raymundo and Michael Simon report
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“Turn off  Siri”
Winner: Siri

Here’s where Siri’s home-fi eld advantage comes in. 
Using Siri, you can change a lot of the iPhone’s basic 
functions and settings. For example, Siri can turn Wi-Fi 
on or off . And if you ask her to “take a selfi e”, Siri will 
launch the camera app and automatically switch it to 
the front-facing viewfi nder. You can also open any of 
your installed apps using Siri, even Google Assistant. In 
addition, you can use Siri to search the App Store. That 
makes it really easy to fi nd a new app you’re looking for.
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“Navigate to work”
Winner: Tie

Both Siri and Google Assistant were very competent 
in fulfilling basic requests. During our test, both voice 
assistants were able to give us directions to “work”, 
show us photos of our pets, make phone calls, and send 
emails and texts. Of course, Siri completed all these 
tasks using the iPhone’s native apps, while Google 
Assistant tapped into Google Maps, Google Photos, 
and Gmail. So, the best assistant in this category will 
most likely depend on whether you’re using the default 
iPhone apps or opted to use Google’s suite instead.
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“Remind me I have a call at one”
Winner: Google Assistant

One of the best uses for our phone assistants is 
reminders. With Siri, you can ask to set a reminder to 
make a call at 1, and it will oblige. The same is true 
with Google Assistant (though it’ll work through your 
Google account, not the Reminders app). However, 
Assistant gives you much more control. Because of its 
conversational nature, you can say “Make that 12:30”, or 
“Change the title to Conference call”, and it will tweak it 
until it’s right. Siri won’t know that you’re talking about 
the same task and will offer to start a new one. 
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“Play Toxic by Britney Spears”
Winner: Siri

Google Assistant can actually access Apple Music, but 
it’s a hit or miss. When we asked it to play Toxic by 
Britney Spears, it started playing a karaoke version. We 
asked several times, actually, and every time Google 
Assistant surfaced yet another weird version, from 
lullabies to random remixes. Siri, on the other hand, 
seemed to have read my mind and started playing the 
original version on the first try. Google Assistant was also 
unable to play the correct Apple Music playlist, and it 
can’t tap into Shazam to identify songs. 
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“Find cheapest flight”
Winner: Google Assistant

Unsurprisingly, Google Assistant really excelled at 
performing complex web searches. When we asked it to 
find the cheapest flight to Palm Springs in October, we 
got all the information almost instantly without having 
to leave the app. Google Assistant was even able to tell 
us the duration of each flight. Meanwhile, Siri defaulted 
to a basic web search using Bing that did not give me 
nearly as much detail right away. 
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“How do you make a toasted sandwich?”
Winner: Google Assistant

Google Home recently gained the ability to offer step-
by-step instructions for making millions of dishes, but 
even the rudimentary recipe search is better on Google 
Assistant. If you say, “Let’s make a toasted cheese 
sandwich”, for example, it will provide a list of recipes 
to choose from, and offer instructions for the one you 
select. Siri isn’t quite so helpful. If you ask it the same 
question, it will search for restaurants that specialize in 
grilled cheese, and even if you ask, “How do you make 
a toasted cheese sandwich?” it will merely take you to 
the Wikipedia page.
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“Make a restaurant reservation”
Winner: Siri

When we asked Google Assistant to make a restaurant 
reservation, it defaulted to pulling information from the 
top web search result. It was disappointing, no doubt, 
and pretty ironic that the web page was a how-to on 
making restaurant reservations via Siri. So, when we 
tried the same query on Siri, it followed up asking 
for a date and time and then gave me a list of nearby 
restaurants with availability using the OpenTable app.
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“Show me the latest Spider-Man trailer”
Winner: Google Assistant

If you ask to “play the latest Spider-man trailer,” Google 
Assistant will automatically provide the expanded 
YouTube link, ready to play right in the app. Siri, on 
the other hand, will understand that you want to play 
a Spider-Man trailer, but it will make you select from 
a lengthy list before it begins playing. But when we 
selected Homecoming from the list, it didn’t bring 
up the trailer. It told us that it didn’t see any movies 
matching it.
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“Tell me a joke”
Winner: Siri

Siri and Assistant both want to be more than 
programmed chatbots, so each has its own personality. 
So, both tell jokes. Or, more specifically, both tell bad 
jokes. Siri and Assistant will both happily oblige to a 
variety of queries (including simply saying “joke”), but 
Assistant’s were a bit more engaging. Siri tended to stick 
to one-liners, whole Assistant’s jokes tended to be more 
question based. (Siri’s sense of humour is also a bit 
more iPhone-centric.) Additionally, you can say, “Tell me 
another”, or “One more” and Assistant will oblige, while 
Siri will need to be specifically told to tell another joke. 
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Ask the iTunes Guy
Kirk McElhearn answers your iTunes questions

Viewing the right information in playlists in 
iTunes can be complicated, in part because 
iTunes defaults to a specific display when you 

create new playlists. In this month’s column, I answer 
a question about choosing which columns of metadata 
display in Music playlists. And I also discuss some other 
nuances about playlist views, and present a few tricks 
to make changing what information playlists display 
easier and more efficient.
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Plus, the bigger your iTunes library, the harder it 
is to keep it coherent. I answer two questions about 
managing a library. The first asks how to sort artists by 
their last name instead of their first name, so it’s easier 
to find music in a large library, and the second discusses 
how to rip CDs when your main computer is a laptop 
without an optical drive.

PlAylist columns

Q When i create a new playlist, it displays with 
a default set of columns, such as icloud 

Download, Rating, and Genre. I would prefer that 
different columns display in my playlists, and I have 
to do this manually. is there any way of changing the 
default columns that display in new playlists?

A This is a great question, because it raises a number 
of issues around how iTunes manages and displays 

playlists. When you create a new playlist in iTunes, it 
defaults to Playlist view. This view displays a number of 
columns, without headers, and you cannot change the 
information that iTunes shows you.

All playlists in this view display exactly the same 
way. Not only can you not change the columns, but you 
can’t choose to not display artwork. That artwork takes 
up extra vertical space if your playlist contains albums, 
since each track displays an artwork thumbnail. In 
this view, there’s nothing you can do about it.

You can get a lot more control of what iTunes 
shows you by changing the display to Songs view, 
from the View > View As menu. Songs view looks like 
the screenshot on page 68.
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With Songs view, you can decide which columns 
display by choosing View > Show View Options. The 
View Options palette lets you toggle on or off dozens of 
columns – each of which displays an item of metadata 
from your files – and also lets you choose to display 
album artwork or not, or change its size.

As I said above, when you create a new playlist, it 
displays in Playlist view, but after you add something 
to that playlist, you can choose View > View As > Songs 
to get the columnar view, then adjust these columns. 
The default columns that display when you switch to 
this view reflect the columns in your main Music library, 
when it’s in Songs view (select Music from the Media 
Picker menu above the sidebar, then click Songs in the 
Library section of the sidebar). So if you want all your 

Songs view is more flexible

IPAD & IPHONE USER 121.indd   68 16/06/2017   12:15



ISSUE 121 • iPAD & iPHONE USER 69

FEATURE

new playlists to show certain 
columns, change the columns in 
Songs view for your Music library.

If you find that you often create 
playlists then switch from Playlist 
to Songs view, you might want 
to create keyboard shortcuts for 
the two views to save time. This 
is a bit complicated, because the 
Playlist and Songs choices are in 
sub-menus, and iTunes also has 
the same menu items in other 
sub-menus. Doug Adams has 
written an article explaining how 
to set up these keyboard shortcuts 
at tinyurl.com/ycgeehrr.

But what if you already have 
a number of playlists, and you 
want to change the columns they 

display in Songs view? You could do this manually, but 
this can take a long time. Doug Adams’ Assimilate View 
Options AppleScript helps you. You select a playlist 
(normal or smart) and run the AppleScript. It creates a 
new playlist using the columns in your Music library’s 
Songs view, copies all the tracks from the selected 
playlist to the new one, then deletes the original.

You may want to have a number of playlists with 
different columns. Perhaps you need to know the BPM 

In Songs view, the View Options 
window lets you control how 
iTunes displays your metadata

IPAD & IPHONE USER 121.indd   69 16/06/2017   12:15



70 ISSUE 121 • iPAD & iPHONE USER

FEATURE

of certain tracks, so some playlists show this column. 
Or you may want to see the play count and last played 
date in some playlists. Or you may want some playlists 
where album artwork displays, and others where it’s 
not visible. You can manually change the columns in 
any playlist in Songs view, as I explained above, but you 
can also create a number of templates.

Create a playlist folder (File > New > Playlist Folder), 
then create a new playlist in that folder (File > New > 
Playlist, or Command-N). Add at least one item to it – a 
placeholder track that you’ll delete later – then switch 
to Songs view (View > View As > Songs). Next, show 
and hide the columns you want to see. When you want 
to create another playlist with these same columns 
displayed, you can duplicate that playlist (right-click 
on the playlist and choose Duplicate), and the new 
playlist will show the same columns. Add some tracks to 
the playlist, then delete the placeholder track you had 
added in the template. Make sure to change the name 
of the duplicated playlist to match what you want.

You could make a few different templates, or even 
dozens, matching the types of playlists you like to 
use. And when you need a new playlist with specific 
columns visible, you can just make a copy of one of 
your templates, than add music to it.

SORTInG ARTIST nAmES

Q i would like to sort the artists and composers in 
my itunes library by last name so they’re easier to 

find in lists. I know I can do this by entering the name 
in the sort Artist tag, but this will take a long time. is 
there any quick way to do this?
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A By default, iTunes sorts everything by its first word 
(with the exception of A, An, The, and equivalents 

in other languages). So it sorts John Cage at the letter 
J, and Buddy Holly at B. But some people find it easier 
to have names sorted by their last name, so they can 
glance at a list and search for the first letter of that 
name, instead of the first name.

There are two ways to do this. The first involves 
changing the actual name of the artist or composer. In 
my library, I sort all classical composers in Lastname, 
Firstname order. So I have Bach, Johann Sebastian; 
Cage, John; and Rautavaara, Einojuhani. I find it easier 
to spot a composer’s name this way, because the sort 
word – the last name – is at the beginning of the list. 
You can do this by selecting 
all the tracks by a composer, 
then pressing Command-I to 
display the Info window. In the 
Composer field, type their name 
in Lastname, Firstname format, 
then click OK.

But I don’t do that for artists. 
I have Bob Dylan, Buddy Holly, 
and Brad Mehldau display as is, 
meaning that I have to glance 
at the second names – which 
aren’t always lined up – to see 
where I am in a list.

With first name sorting, it can be 
confusing to find an artist in a list

IPAD & IPHONE USER 121.indd   71 16/06/2017   12:15



72 ISSUE 121 • iPAD & iPHONE USER

FEATURE

But why not have those artists display with their 
first names first, but sorted by their last names? 
This is possible. Select all the tracks by an artist, 
click Command-I, then click Sorting. This tab of 
the Info window lets you tell iTunes how to sort 
the artist, album, album artist, or composer. In the 
Artist section’s Sort As field, enter the artist’s name 
in Lastname, Firstname format.

It can take a while to do this for all your artists, 
but there’s a shortcut. Doug Adams’ Artist to Last First 
AppleScript (tinyurl.com/ya7xtkq3) can set the sort 
tag this way for a whole batch of music. It can change 
a name to Lastname, Firstname order, and insert it in 
the appropriate sort tag, and it can even move the ‘The’ 

Sort artists by their last name by 
entering the sort form in this field

IPAD & IPHONE USER 121.indd   72 16/06/2017   12:15



ISSUE 121 • iPAD & iPHONE USER 73

FEATURE

at the beginning of a band’s name to the end, so you 
could have The Jimi Hendrix Experience display as 
Jimi Hendrix Experience, The.

RIPPInG CDS On A LAPTOP

Q i have a macBook without an optical drive, and 
most of my itunes library as stored on an external 

hard drive using an app called tunespan. i also have 
an old imac with an optical drive. How can i use the old 
imac to rip cDs and get them in my macBook’s itunes 
library? Can I use my external drive in some way?

A It’s almost as if Apple doesn’t want people to buy 
CDs. To start with, if you don’t want to use iCloud 

Music Library, you have the problem of storing a large 
media library on a laptop that may not have a lot of 
storage. TuneSpan, which we covered back in 2012, 
lets you move some or all of your iTunes library to an 
external drive.

When you want to add more CDs to the laptop, 
you have two choices: use a second computer, which 
you have, or buy an optical drive and connect it to the 
laptop via USB. You can get an external, self-powered 
optical drive for about £25, and this might be a good 
thing to have if you plan to rip a lot of CDs.

If you rip CDs on the iMac, you can just copy them to 
any external drive, then add them to your iTunes library. 
This is important; you can’t just put them in the iTunes 
Media folder on the external hard drive you have. You 
have to connect that drive and add the files to iTunes 
in order for iTunes (and in your case TuneSpan) to then 
move the files to a location that it understands.
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Surfing the web on a public Wi-Fi can be dangerous 
business, opening your iPhone or iPad up to 
spying eyes. To avoid that, you could use a VPN 

to stay private and anonymous. 
A VPN also hides your location online, which can 

allow you to access blocked content and blocked 
sites such as US Netflix when you are in the UK or 
BBC iPlayer when you are abroad. Here we talk you 
through the best iOS VPN options.

Best VPN for iOS
A VPN lets you stay anonymous online, and access blocked content 
like Netflix US. Ashleigh Macro reveals your different options
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It’s important to note that it is against Netflix, 
BBC iPlayer and other blocked content’s terms and 
conditions to access them using a VPN, so proceed 
with caution as you risk getting your account blocked.

PureVPN
Price: From £2.30 per month at fave.co/2pYjebX

Our pick of the best VPN for iPad or iPhone is PureVPN. 
It’s a popular and trusted option, and it’s competitively 
priced too. The VPN includes a built-in auto-redial that 
automatically reconnects should your connection drop 
for uninterrupted browsing, and there are more than 
500 servers available across 140 countries.

Its iPhone and iPad app is simple and smart, and 
lets you tailor your connection based on the Internet 
activity you intend to do.

CyberGhost
Price: From £3.74 per month at tinyurl.com/ydg9ptgj

CyberGhost is a great option, and it’s also brilliantly 
priced. It’s headquartered in Romania, which is outside 
the ‘14-eyes group’ of countries that share signals 
intelligence. One of the great things about this VPN is 
its ease-of-use. It’s simple to use, and does lots of the 
hard work for you. There are more than 800 servers 
available to connect to over 29 different countries, 
although they don’t always work with Netflix US.

There is a free version of CyberGhost but that 
won’t give you access to the mobile apps. For that 
you’ll pay £3.74 per month on the Premium Plan.
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Private Internet Access
Price: From £2.60 per month at tinyurl.com/csvru36

At around £3 per month, Private Internet Access 
off ers anonymous browsing and access to blocked 
content including Netfl ix US.

The iPhone and iPad app is incredibly simple and 
easy to use, and it’s also very fast. A solid option.

NordVPN
Price: From £5 per month at fave.co/2pWW9bM

Based in Panama, NordVPN is another VPN based 
outside of the jurisdiction of the ‘14-eyes’. There are 
more than 500 servers available across 51 countries, 
and encryption levels are among the highest available 
in a VPN. You can connect to up to six devices at one 
time with your NordVPN account, which off ers pricing 
starting at around £4 per month.

IPVanish
Price: From £5 per month at tinyurl.com/L5x8rnb

Another option that off ers lots of great features is 
IPVanish, which is both good-looking and easy to use. It 
has 750 servers in 60 countries. It’s going to appeal to 
beginners, as it’s one of the most intuitive VPNs we’ve 
used, but it does have one downside and that is that it’s 
located in the US. That’s not a problem for most casual 
users, but if 100 percent privacy is your main concern 
then you might want to look elsewhere. The company 
does promise that it doesn’t keep any logs, though.
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ExpressVPN
Price: From £6.50 per month at tinyurl.com/mjngk8a

ExpressVPN off ers apps for all operating systems 
including iOS. You can connect to three devices 
at once, and there’s no limit to bandwidth, server 
switching or speed.

TunnelBear
Price: From Free per month at tinyurl.com/y8uz9m35

TunnelBear off ers a limited free version of its VPN 
service that you can try before you commit to the 
year-long option for $59.98 (£47.20) which works out 
to just under £4 per month, or a one month option for 
$9.99 (£7.86). Once signed up, you can connect to up 
to fi ve devices simultaneously.

ExpressVPN
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How to: Access a music 
library from an iPad

Reader Nelis van Nahuijs has a fascinating question 
about switching – not from or to an Apple 
platform, but from a Mac to an iPad.

My daily use is reading several digital newspapers, 
listening to music from my iTunes Library, watching 
television, and reading books in iBooks. I write rather 
often in Pages and Scrivener. Occasionally, I watch 
movies and series in Netflix.

If only there was a way to rip CDs on a Mac. Glenn Fleishman reports
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But the fly in the ointment is their extensive music 
library, which currently resides on an external drive, 
and they still purchase and rip CDs to add to it.

I’ve been puzzling through this, and it seems like a 
computer will still be needed to prep and upload music 
files, though not to listen to them – as long as you don’t 
choose iCloud Music Library to store the files.

Amazon Music is probably the best choice. With a 
Prime membership, you can upload unlimited photos, 
and up to 5GB of other files, including music. With an 
Amazon Drive subscription (tinyurl.com/yasrv22r), at 
£55 per year, you have unlimited file uploads of all 
kinds. This music can then be streamed or cached in 
the Amazon Music app for iOS (and on several other 
platforms). However, you still have to upload the music, 
and there’s no iOS option for that. You need a Mac or 
Windows PC and Amazon Music software (which is free). 
Conceivably, with an external USB CD/DVD drive and an 
external disk drive, you could lean on a friend now and 
again to rip disks and upload to your account.

Because Amazon Drive offers unlimited storage, 
you can also use this for online backups, paired with 
software such as Arq (arqbackup.com), which can use 
it just like any other backup destination.
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How to: Delete iOS apps

If you’re like most iOS users, you have lots of apps. It’s 
all too tempting and all too easy to buy new ones (or 
download free ones) from the App Store. As a result, 

you probably have a number of games, productivity 
apps, and utilities on your iPhone or iPad that you’ve 
hardly ever used and aren’t likely to use in the future.

But if you keep doing that, those apps will start to 
crowd your iOS device (and your iTunes library), taking 

Glenn Fleishman reveals how to cull old apps from your device
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up space and requiring frequent updates. That’s why 
it’s a good idea to periodically get rid of the apps you 
don’t use anymore. (You can always download them 
again from the App Store if you change your mind.) 
Culling your apps library can make managing your app 
collection easier and free up precious storage space. 
Here are four ways to do it.

Tap and wiggle
Deleting apps on an iOS device is simple: just tap and 
hold any app icon until all the icons start wiggling. 
You’ll notice that many, if not most of them, have a 
little X at the top left corner. (The ones that don’t have 
the X are default apps that are part of iOS; you can’t 
delete those.)

To delete an app, tap the X, then tap Delete in the 
dialog the displays. Note that doing so deletes not only 
the app, but also all of its data. So if you think you’ll 
need an app again soon, and you have stored data, 
settings or completed levels for it, you might want to 
think twice before tapping that X.

From Settings
Another way to delete apps on an iOS device is from the 
Settings app. Tap Settings > General > Storage & iCloud 
Usage, then under Storage tap Manage Storage. Look 
at the apps that display Under the Used and Available 
listings. This list is useful because it shows how much 
storage each app actually uses. That may include just 
the app itself or the app plus all its attendant files and 
data. If you need to free up a specific amount of space 
– perhaps when you want to download a movie – this 
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is a good place to look. Deleting from here is simple, 
too: tap on an app’s name, then tap Delete App. You 
may find this quicker than tapping icons if you want to 
delete a lot of apps at one time.

From iTunes
When you delete apps from your iOS device, iTunes will 
not copy them back on to your device the next time you 
sync it. So the above techniques are great if you want to 
delete apps from specific devices but still retain them 
in your iTunes library.

If, on the other hand, you want to nuke them entirely, 
go to iTunes and choose your Apps library. Click an app 
to select it, then press the Delete key. Another dialogue 
will ask you to confirm. (You may indeed want to keep 
them; Ted Landau recently posted a tip discussing why 
that can be useful.) You can remove the apps from 

You can right-click on an 
app in your iTunes library 
and select Delete
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your iTunes library, but keep them in a folder on your 
Mac just in case. It may help to view the apps in your 
iTunes library in a list. Click the View menu, then select 
View As > List. Click the Purchase Date header to sort 
by the date you purchased the apps. If you don’t see 
a Purchase Date header, click on the View menu and 
select Show View Options, then in the pop-up window, 
look in the Stats section and check the box for Purchase 
Date. You can also right-click on a blank header in 
the iTunes list and select Purchase Date in the pop-
up menu.  (The Purchase Date is either the date you 
downloaded an app or, if it has been updated, the date 
of its last update.) Look at the apps with the oldest 
purchase dates to decide if you still use them.

When updating
There’s one other way you can delete apps from your 
iTunes library, and it’s one I use often. I have hundreds 
of apps, many that I use regularly, but most that I only 
tried out. It takes too long to go through my Apps library 
and try and remember what each app does. So I wait 
until there are updates.

In iTunes’ Updates section, you’ll see a list of new 
versions of apps that you can download, when an app 
has been updated. When I see an app in the Update 
window that I don’t use anymore, I delete it. To do this, 
right-click on an app’s icon and choose Delete from 
Library. This deletes the app itself from your iTunes 
library, and also removes the update notification. The 
next time you sync your iOS devices, the apps you have 
deleted from your iTunes library will be removed from 
your devices.
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How to: Find a missing app

If you have lots of apps, you probably have a number 
of games, productivity apps, and utilities that you’ve 
hardly ever used and aren’t likely to use in the future. 

But what happens if you accidentally delete one? If 
you use Spotlight to find the app (swipe down, enter 
its name), you’ll see next to the results what folder 
it’s in. Check that folder. If that doesn’t work uninstall 
and reinstall the app, which will delete all associated 
data. Use Settings > General > Storage & iCloud Usage 
> Storage to find the app, tap it, and then you can tap 
Delete App. (If you sync with iTunes, you can also delete 
via iTunes.) Many apps sync via the cloud, so hopefully 
the app is one of those.

Glenn Fleishman explains how to retrieve a lost app on iOS
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How to: Bulk delete photos

Deleting hundred of images on your iPhone 
by tapping individual pictures is tedious. 
Thankfully there is a solution. Plug your iPhone 

into your Mac using the included syncing cable and 
launch Image Capture. This is a handy utility for 
grabbing images from connected devices (including 
scanners, cameras, and iOS devices). Select your iPhone 
in Image Capture’s Devices column. Below, choose a 
destination for your imported images from the Import 
To pop-up menu – your choices are the Pictures, 

Chris Breen ’s technique will speed up the process
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Movies, Desktop, and Documents folders as well as 
iPhoto, Aperture, Preview, and Mail. Select Other and 
you can choose any folder you like. To import your 
photos click the Import All button at the bottom right 
of the window. This will import all the images in your 
iPhone’s Camera Roll.

When you’ve done this, press Command-A to select 
all the iPhone’s images and then click the Delete 
button (which displays the international circle-with-
a-slash icon). You’ll be asked to confirm that you want 
to delete your images. Confirm-ho and the images will 
be deleted.

Alternatively, after you’ve backed up your images 
you can delete them in batches directly on your iPhone. 
To do that launch the Photos app, navigate to the 
Photos tab on the left until you get to Moments view. 
Then tap Select at the top-right of the screen, and tap 
each Select link next to each batch of images you want 
to delete. Tap the Trash button in the bottom-right 
corner, confirm that you want to remove the images, 
and they’ll be deleted.

You’ll also need to switch off Photo Stream on your 
iPhone. To do that go to Settings > Photos & Camera. 
In the resulting screen flick the My Photo Stream switch 
to Off. This will cause the pictures to disappear from 
your phone.

The advantage of this technique versus deleting the 
images in your Photo Stream is that copies of these 
pictures are still on iCloud and the devices for which 
you’ve enabled Photo Stream. Note that should you 
switch Photo Stream back on, any images that are part 
of Photo Stream will be downloaded to your phone.
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In the movie The Princess Bride, after a series of 
exciting events, sword master Inigo Montoya is asked 
to explain what has happened since the film’s hero 

was rendered unconscious. “Let me explain,” he says. 
“No, there is too much – let me sum up.”

When it comes to explaining the WWDC 2017 
keynote, I feel a lot like Inigo Montoya. This was a 
packed two-plus hours that would probably run three-

WWDC: Taking it all in
Apple kicked off WWDC with a software and hardware showcase 
we’ll be thinking about for a long time to come, writes Jason Snell

opinion
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plus hours in the Director’s Cut edition. There were 
enough Easter eggs in the ‘additional features’ slides 
to render the Easter Bunny catatonic. There’s a lot to 
process, and we’ll be processing it for the next few 
days – maybe even all summer.

But in the meantime, here are a few big-picture 
takeaways from Apple’s presentation.

Apple walks the walk for professionals
When Apple gathered writers together earlier this 
year to emphasize the company’s commitment to 
professional Mac users, that seemed to be a mea 
culpa to pro users, with the implication that in the 
future, Apple would serve them better.

The announcements were, in essence, Apple walking 
the walk after previously talking the talk. Not only 
did the company announce the forthcoming iMac Pro, 
whose existence was strongly hinted at during that 
briefing, but it offered speed improvements across 
the entire line of laptops – including the addition of 
Kaby Lake processors to the MacBook Pro line that was 
only introduced eight months ago.

According to most reports, the iMac Pro was 
designed at a point when it was intended to be the 
replacement for the Mac Pro. While its existence now 
makes me wonder exactly what role the new Mac 
Pro will serve in the Mac product line, the fact is that 
the iMac Pro appears to be a desktop computer truly 
focused on the needs of high-end professionals. I talked 
to game developers who were beside themselves with 
delight over the specs of the new iMac Pro. No, it’s not 
for everyone – this is a computer that starts at $5,000 
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(£TBC), after all – but it’s loaded up and ready for the 
very people who might want such a thing.

And don’t discount the importance of Apple 
shipping those Kaby Lake updates. Apple’s sluggishness 
in updating Mac hardware to take advantage of 
speed improvements from Intel is a key reason why 
professional users have been frustrated with Apple. 
This set of speed-bumped models may not seem like 
headline news, but it’s important because it shows 
Apple updating the Mac in a more timely fashion. It’s 
a big deal – though Apple’s not out of the woods yet. 
It needs to continue to update its computers on a 
regular basis, rather than leaving them unaddressed 
for a couple of years at a time.

Apple’s not sleeping on VR and AR
Apple’s competitors have been trumpeting virtual 
reality (VR) and augmented reality (AR) tech for a 

Apple iMac Pro will 
ship in December 2017
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while now, while Apple has remained relatively quiet. 
But no longer: the keynote made it clear that Apple 
takes VR and AR seriously and it’s investing in those 
technologie for the long haul.

Perhaps one day Apple will manufacture its own 
VR or AR hardware, but that day isn’t here yet, and 
probably won’t be for a while. That’s not a big deal, 
though, when it’s already sold millions of devices with 
cameras and a lot of processor power. The demo of the 
day was probably Wingnut’s amazing augmented-reality 
game play, which took place on top of a demo table 
on stage. We got a first idea about the possibilities for 
augmented reality last year from Pokémon Go, but with 
ARKit, Apple is providing its developers with the power 
to roll out many more high-quality AR experiences on 
iOS. It’s a big deal.

Apple demonstrated VR 
capabilities coming to the Mac
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On the VR side, the story’s a bit muddier. It looks 
like you may soon be able to actually play VR games 
on a high-end Mac, and the Industrial Light and Magic 
Star Wars VR demo suggests that developing VR games 
on a Mac will actually be possible, especially on the 
new iMac Pro. I firmly believe that in the long run, VR 
headsets driven by mobile processors will be how we 
use VR, but in the interim it’s nice to think that the Mac 
isn’t a backwater, but a platform that’s actually getting 
serious about being a VR platform.

The iPad Pro gets its wings
After seven years in the iPhone’s shadow, with iOS 
11 it really feels like the iPad is coming into its own, 
diverging dramatically from the approach of the iPhone. 
With the new Dock, multitasking view, drag and drop, 
and Files app, Apple is bringing Mac-style functionality 
to the iPad, but in a uniquely iOS style.

There’s a lot to digest about how iPad multitasking 
has been altered in iOS 11 – the new multitasking view 
replaces both the application switcher and Control 
Center, for example – but in the end these are features 
that will be embraced by people who want to use the 
iPad Pro to get work done, and ignored by those who 
don’t care so much.

The influence of macOS is undeniable: Files is a lot 
like the Finder, the Dock is extremely Mac-like (but with 
Siri app suggestions instead of a minimized-window 
area), and drag and drop feels familiar. But that’s to 
be expected, because the Mac has evolved over the 
years to fulfil the needs of many users. iOS is newer, 
and still evolving, but its more serious users have those 
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same needs. On the Mac, Finder is the default – the 
‘home screen’ for every user. On the iPad, that’s not 
the case, but the Files app is there if you need it.

Apple Music steps forward, Siri steps back
In gauging rumours about the WWDC keynote, I felt 
it was likely that this would be a major event for Siri. 
Siri definitely got a lot of screen time – new voices and 
notifications, new proactive assistants in a bunch of 
places, and of course Siri’s presence on the HomePod 
– but none of it felt cohesive. In fact, it feels like Apple 
is continuing to chuck a whole lot of features into a 
box and call it Siri, despite the amorphous definition of 
what exactly Siri is. It’s a voice assistant, but sometimes 
also text. It’s not the same on iOS as Apple TV, nor on 
macOS as on Apple Watch.

The announcement of the HomePod could’ve been 
a huge win for Siri. Here, at last, was a device that 

Apple HomePod is 
positioned first as a home 
music system, then as a 
digital assistant capabilities
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puts Siri into the centre of your living room, ready to 
receive your orders. Instead, though, the HomePod 
was a showcase for music in general and Apple Music 
in particular. We heard a great deal about tweeters, 
woofers, audio processors, and the like during the 
keynote – and then there was a brief segment about 
Siri toward the end.

What does this all mean? My guess is that Siri is such 
an amorphous catch-all of evolving features that Apple 
was reluctant to lean on it too hard in the introduction 
of the HomePod. Instead, Apple Music’s large library, 
curated playlists, and personalized recommendations 
carried the day. This isn’t a bad call for Apple to make – 
on sound quality alone it attacks the greatest weakness 
of the Amazon Echo – but it’s interesting to see just 
how soft-pedalled the Siri references are. Maybe 
Apple’s not as confident about Siri as we think it is?

A jam-packed event
Let me sum up: when you, as a company, have four 
major software platforms and a gaggle of hardware 
products in need of updating, you have a day like 
this. It will take days, if not weeks, for all the content 
of Apple’s keynote to sink in. This is the opening gun 
of Apple’s product year, and there’s much more to be 
learned. But I’m impressed with the richness of this 
year’s keynote. Apple strikes me as a company with 
something to prove this year, showing a hunger that 
hasn’t been apparent in the past few years. That’s a 
good thing. I like it when Apple feels it needs to prove 
itself, to users and developers alike. The company is at 
its best when it’s stepping up to a challenge.
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One of the words I use a lot when reviewing 
Apple products is opinionated. I believe that 
great art or design can’t happen without a point 

of view – and the more you depart from a focused point 
of view, the more likely a creation will be compromised, 
workmanlike... good, maybe, but not great.

When it’s at its best, Apple strives for greatness. It 
doesn’t always get there – and every now and then you 
get the sense it’s not actually trying to get there – but 
when things are hitting on all cylinders, Apple releases 
products that are backed by a strong point of view 
about what will delight and serve its customers.

Apple Park: Steve Jobs’ 
last great product

Apple’s new Cupertino campus is a reflection of the company’s 
co-founder, argues Jason Snell
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The MacBook, for example, is a product based on a 
focused vision: That a single port and a slower class of 
processor are worthy trade-offs for an incredibly thin 
and light computer with a Retina display. You don’t have 
to agree with Apple’s take – in the case of the MacBook, 
the company’s practically daring you to disagree – but 
you can’t deny that it’s an amazing execution of a 
particular set of priorities.

I’ve been thinking about Apple’s approach to 
products recently because I read Steven Levy’s 
excellent inside look at the new Apple Park campus for 
Wired. It’s worth a read – I highly recommend it, if you 
haven’t dug in yet. Levy’s been covering Apple longer 
than just about anyone, and in great detail. In his story 
about Apple Park, he suggests that the facility itself is 
an Apple product – in fact,  the last product to truly be 
conceived of by Steve Jobs. Here’s a key section:

Apple Park is the architectural avatar of the man who 
envisioned it, the same man who pushed employees 
to produce those signature products. In the absence 
of his rigor and clarity, he left behind a headquarters 
that embodies both his autobiography and his values. 
The phrase that keeps coming up in talks with key 
Apple figures is ‘Steve’s gift’. ... The current leaders of 
Apple are determined not to disappoint him in what is 
arguably his biggest, and is certainly his last, product 
launch. “I revere him,” Cook says. “And this was clearly 
his vision, his concept. Our biggest project ever.”

As detailed by Levy, Apple Park is an Apple product 
through and through. The company took great care to 
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make design decisions, and create custom hardware, 
at many key points – from the massive glass sheets 
that required the building of a gigantic furnace, to 
the toilets, to the handles on the doors, to the pizza 
boxes in the cafeteria. It’s a one-off product designed 
by Apple for itself, yes, but it seems to have received 
the same attention to detail as any other major 
product launch.

(In fact, reading Levy’s story, I wondered to myself 
if some of Apple’s product sluggishness over the last 
couple of years might be somehow related to the 
design energy going into the new campus. Probably 
not, but you never know. I’m more concerned about 
the hit in productivity the company may experience 
when it has to move so many of its employees to new 
workspaces and allow them some time to adapt to 
their surroundings.)
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In the end, Apple’s choices about the materials used 
in construction and the hardware adorning Apple Park 
aren’t that important (unless you work there). What does 
fascinate me is one bit of criticism levelled at the plan, 
which says a lot about Steve Jobs’s vision for Apple and 
how it conflicts with the approaches many other tech 
companies are making:

[There are critiques] that the campus is a snobby 
isolated preserve, at odds with the trendy urbanist 
school of corporate headquarters. (Amazon, Twitter, 
and Airbnb are all part of a movement that hopes 
to integrate tech employees into cities as opposed 
to having them commute via fuel-gobbling cars or 
numbing Wi-Fi-equipped buses.) That the layout of 
the Ring is too rigid... That there is no childcare centre. 
“It’s an obsolete model that doesn’t address the work 
conditions of the future,” says Louise Mozingo, an urban 
design professor at UC Berkeley.

Steve Jobs’s vision for Apple’s headquarters was 
to stay close to home, in the low-density suburbs that 
form Silicon Valley, rather than embrace a more high-
density, urban environment. Apple’s never been a city 
company, from its very start in that suburban garage. 
Using that as a given – Apple’s a company that isn’t 
going to stray too far from its suburban roots – Jobs 
envisioned a hub of activity surrounded by a tranquil 
park of hills and trees that are reminiscent of the area 
when it was mostly fruit trees and fields, before it 
became a major hub of American innovation. Apple’s 
decision to make Apple Park a ring will be a convenient 
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metaphor for those who wish to criticize the company 
for being secretive, insular, and arrogant – Levy quotes 
one critic who calls it a “retrograde cocoon.” There will 
be more, and worse, when the campus opens and in the 
years thereafter.

Take those criticisms as you will, but anyone who’s 
visited Apple’s Infinite Loop campus – constructed in 
1992-93 – will tell you that Apple’s been buildings set 
in a ring with a large private space in the centre for 
25 years. Building oases in the middle of South Bay 
suburbs – this is in Apple’s DNA.

Sometimes you need to be true to yourself. I think 
it’s fair for Levy to note that Apple is not doing what 
some other major tech companies are doing, and 
integrating their campuses into urban environments. 
I was in Seattle earlier this month and got to go past 
Amazon’s biosphere, where many large office buildings 
devoted to Amazon are integrated with a weird set 
of domes and a bustling urban area with shops 
and restaurants. Twitter moved onto Market Street 
in San Francisco, and start-ups have thrived in San 
Francisco’s South of Market area for years.

There’s a lot to be said for embracing urban areas, 
rather than hiding in the suburbs. From a commuting 
perspective, the suburban office park is terrible. Apple’s 
campuses, old and new, are poorly served by public 
transit, leading the company to create a parallel transit 
system of fancy Wi-Fi equipped buses. City centres 
are, in contrast, generally served well by regional 
transportation systems. A friend of mine recently got 
a job at Google and was wondering which would be 
better for her commute-wise – the horror stories of 
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how expensive it is to live in San Francisco (Google 
has an office building just north of the Bay Bridge) 
made her assume that the suburban Mountain View 
campus would be preferable. I had to explain that San 
Francisco was actually a better location, because it’s 
served by the regional BART train system as well as 
ferries from across the bay.

It’s hard to imagine Apple colonizing downtown San 
Francisco, just as it’s hard to imagine Google building 
its new campus in high-rises in San Jose. I can’t imagine 
Microsoft decamping from its suburban campus in 
Redmond, either. Then again, Adobe – who previously 
occupied what is now the centre of the Googleplex – 
did decamp to new high-rise buildings in San Jose.

In the long run, I think it’s a mistake for big 
companies to build sprawling suburban headquarters 
in areas poorly served by public 
transportation. I applaud Twitter 
and Amazon’s embracing of the 
urban centre. (And Google’s 
decision to include childcare 
centres in its facilities plans, 
unlike Apple and Microsoft.)

But I understand why 
building outside of the suburbs 
was never really a serious option 
for Apple – or its Seattle cousin 
Microsoft. Like their co-founders 
Steve Jobs and Bill Gates, they’re 
suburban kids who never seem 
to have really gotten a taste for 
the big city.
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